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ABSTRACT 

During my internship at Idea Lab within the MCT (Multimedia and Creative Technology) 

department, I engaged deeply in the creation of 3D models and Interior Design focusing primarily 

on Autodesk Maya. Over the course of six months, I successfully completed diverse 3D models, 

Interior Design demonstrating proficiency and receiving commendable feedback from Idea Lab.  

 

The internship experience was structured to provide a comprehensive understanding of the  

entire 3D production pipeline. This encompassed initial stages such as storyboarding and  

conceptualization, followed by meticulous tasks including modeling, texturing, animation,  

lighting setup, rendering, and post-processing. Each phase was crucial in refining my skills  

and understanding the nuances of crafting immersive and visually compelling 3D content.  

Collaboration with Idea Lab allowed me to immerse myself in professional  

workflows and gain practical insights into client expectations and project management in  

the competitive marketplace. This exposure not only sharpened my technical abilities but  

also enhanced my ability to communicate ideas effectively through visual media. 

  

Overall, my internship at Idea Lab has been instrumental in advancing me proficiency in 3D 

modeling, interior design, and understanding the complexities of professional 3D modeling and 

Interior projects. It has equipped me with invaluable skills and experiences that are essential for a 

successful career in the dynamic field of 3D Modeling and Interior Design. 

  

In the past six months, I have completed my projects and received positive feedback from  

the Idea Lab. I am now confident in my ability to create any Interior Design or Models  

using Autodesk Maya software. 
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CHAPTER 1 

INTRODUCTION 

In today's digital age, the field of 3D modeling and Interior design stands at the forefront  

of technological innovation and creative expression. As a student in the Multimedia and  

Creative Technology (MCT) department, my journey into this dynamic realm has been  

shaped significantly by my internship experience at Idea Lab. Over the course of  

my internship, I engaged deeply in the creation of diverse 3D models, Interior Design. 

.  

This report delves into the comprehensive process of modeling these 3D assets, providing  

detailed insights into the methodologies, techniques, and creative decisions involved. Each  

model presented within this document represents not only a technical achievement but also  

a testament to the fusion of artistic vision and practical skill development cultivated during  

my tenure at Idea Lab.  

 

Through rigorous exploration and hands-on application of software tools like Autodesk  

Maya, I endeavored to capture the essence and functionality of each object while adhering  

to industry standards and client specifications. This report serves as a comprehensive  

documentation of my learning journey, highlighting the challenges encountered, solutions  

implemented, and lessons learned in the pursuit of mastering 3D Model and Interior design. 
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CHAPTER 2 

 

CASE STUDY 

 

This case study explores the transformative journey of me, a student from the Multimedia 

and Creative Technology (MCT) department, during my internship at Idea Lab. This project 

that I have to study a lot because here I work with product modeling and Interior Design. I 

model Interior Furniture and products according to the current market. 

 

I came here thinking about the current situation. To complete this project, I will learn many 

things there are I improve my modeling skills, light and also substance texturing. This is 

not easy for me. I search a lot of resources and watched lot of tutorial for our skill 

improvement. 3D Modeling and Interior Design a lot of high quality renders that I put a lot 

of hard effort into. 

 

My internship experience at Idea Lab proved instrumental in shaping my skills and 

aspirations in the field of 3D Interior Design. This case study underscores the importance of 

hands-on learning and mentorship in nurturing talent and fostering creativity within the 

digital media industry. My journey serves as a testament to the transformative power of 

practical experience and dedication in mastering the complexities of 3D Interior and 

modeling and visualization. 
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CHAPTER 3 

TECHNIQUE & METHOD 

 

TECHNIQUE & METHOD 3.1 

 

In this chapter, I will discuss the software and the techniques. I have used to execute this 

project along with the methods I adopted for increased efficiency. 

 

3.1.1 AUTODESK MAYA: 

 

 

Figure 3.1.1: Autodesk Maya 

 

 

Autodesk Maya is a professional tool for 3D computer animation, 3D rendering, and 3D 

modeling; it helps create the best visual effects, animated films, and series for television. 

Throughout most of its 23-year lifetime, it has been regarded as the industry standard. It 

finds a range of applications due to configurable workspaces that let users set up the 

software on their workflow basis. The polygon, NURBs, and sculpture modeling tools of 

Maya are supplemented with a UV editing tool to give 3D modeling capacity, although it 

distinguishes itself with a bewildering array of animation and rigging features that go 

beyond basic modeling. I used Autodesk Maya in this project for the stylized 3D Interior, 

mainly created with its polygon, NURBs, and sculpting tools, and rendered using Arnold. 

Reference: Autodesk. Maya Overview. 
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3.1.2 Z-BRUSH: 
 

Figure 3.1.2: Z-Brush 

Z-Brush is widely regarded as the most advanced digital sculpting software in the industry 

today. It gives professionals involved in filmmaking, game development, conceptual arts, 

and illustration the ability to sculpt and paint virtual clay in real time. By offering many 

customizable brushes that feel and act like traditional media tools in the real world—Brush 

automatically adds more polygons only when needed it's an extremely smooth, high- 

resolution sculpt. These enable you to combine, subtract, and intersect independent shapes 

to form complex models. Besides, the interface can be customized to one's favorite 

workflow; hence, making one comfortable and efficient in their working environment. Z- 

Brush uses game developers to design characters, environments, and props. In general, Z- 

Brush appears to be a very impressive tool that assists artists in creating amazing works or 

detailed 3D models. References: School of Motion. 

 

3.1.3 CHAOS V-RAY RENDER ENGINE: 
 

 

Figure 3.1.3: V-ray Render Engine 

 

V-Ray is a rendering engine that utilizes global illumination technologies, such as route 

tracing, photon mapping, irradiance maps, and directly calculated global illumination. This 

program is used to produce images in real-time, delivering fantastic results despite the 

lengthy rendering time for each frame. Reference: Chaos Official. 
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3.1.4 ADOBE PHOTOSHOP: 
 

 

Figure 3.1.4: Adobe Photoshop 

 

 

Adobe Photoshop is one of the popular raster graphics editing software that has extensive 

usage in respect to image editing and designing, digital art. It uses layering to provide depth 

and flexibility for design or editing a work and has powerful editing tools which do almost 

everything when combined together. In this project, I have used Adobe Photoshop for 

combining reference images to create templates for modeling. Moreover, I have also 

prepared rendered images to be presented in Photoshop. Reference: Adobe. Photoshop 

Overview. 
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3.2 COMMONLY USED TECHNIQUES 

In this section, I have covered the most popular techniques used in modeling products and 

game assets. On their own, these techniques are very popular; together, they will provide us 

with an excellent set of tools to speedily and easily come up with beautiful, high-quality 3D 

models. 

 

• LATTICE DEFORMATION 

A lattice is entirely a point structure that can help one in performing free-form deformations 

to any tensor field. The object can therefore be deformed by either translation, rotation, or 

scaling of the structure of the lattice or point-wise by manipulating the defined lattice points. 

Such a way of deformation by lattice is often very useful for controlling the shape of the 

object. In this project, I employed lattice deformation to make huge changes in a shape of 

an object and broke the symmetry. 

 

• BEND DEFORMATION 

The Bend deformer allows you to bend any deformable object in a circular arc. They are 

also useful in both character creation and modeling. Bend deformers have handles that turn 

on and off to let you intuitively control and manipulate the amount of bending effect and 

curve. In this project, I used the bending deformation to involve and stylize objects in 

different ways. 

 

• MULTI-CUT TOOL 

The multi-cut tool in Maya allows us to cut, slice, and insert edge loops efficiently. In 

Smooth Mesh Preview mode, we can extract or delete edges along a cut. Also, we can insert 

edge loops and cuts with edge flow and subdivisions, edit. I used the multi-cut tool in my 

modeling process in a handier way for inserting edge loops. It has made controlling the 

outlook of the model very easy by providing proper edge flow and a level of bevel. 
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• SLIDE EDGE TOOL 

We can use transform constraints from the modeling toolkit to move a subset of components 

along their existing edges. Later on, this is very good for reorganizing or straightening edge 

loops and vertex flow without marring the surface; it works with the move, rotate, and scale 

tools. The Slide Edge tool allowed me easy edge shifting along a surface without any drastic 

changes. 

 

• SOFT SELECTION 

Soft selection is a way to select and move around vertices, edges, and even faces UV or 

multiple mesh in a very organic and fluid method. It's very good to create perfect, smooth 

slopes or contours without needing to transform each vertex individually. In this project, I 

used soft selection to move around vertices and faces when I wanted to add some 

irregularities and variations to my models. 

 

• MIRROR 

The Mirror command duplicates a mesh and reflects it over the invisible mirror plane. This 

geometry can be regionalized and manipulated later by placing this plane manually. We can 

mirror a mesh when we need to construct something which is completely symmetrical but 

we don't want to use twice the amount of time performing the task for which we need it. I 

used the mirror tool quite a lot during my project in order to quickly build up the object 

before moving on to break its symmetries. 

 

3.3 METHODS FOR INCREASED EFFICIENCY 

In this section, I'll go over the methods that helped me create a quicker and more effective 

workflow for watching Simon Fucks (Military Radio) Tutorial. 
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• CUSTOMIZED SHELF 

Autodesk Maya gives its users the opportunity of creating a custom shelf with any tool, 

action, menu item, or script of their choice. A custom shelf saves us a lot of time by allowing 

us to rapidly access the tools and options we use frequently. 

For this project, I have created a custom shelf for myself and added all the tools and actions. 

I needed to model game assets efficiently including Boolean, Hard & Soft Edge, Align, 

Latice, Mirror, UV, Hard Edge Selection, Smooth, Unsmooth, etc. to establish a productive 

workflow. 

 

Figure- 3.3.1 Custom Shelf Maya 

Z-Brush allows its users to create a custom shelf with any tool, action, menu item, or script 

of their choice. 

For this project, I have created a custom shelf on Z-Brush and added all the tools and actions. 

I needed to model game assets efficiently including Auto Group UV, Group Visible, Grow 

Mask, Shrink Mask, Sharpen Mask, Mask by Feature, Polish, Export Obj, Import Obj, etc. 

to establish a productive workflow 

 

 

 

Figure- 3.3.2 Custom Shelf Z-Brush 
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• GROUPING 

Grouping is the best way to conglomerate the elements of a complex asset or a scene. It 

makes it easier to track and select elements. We will group under subgroups, different parts 

of an asset, for example, all under one main group. 

For example- I used grouping for game asset project helping low poly and high-poly baking. 

 

Something like this- 

• Final Model Group 

• High-poly group 

• high_01 

• high_02 

• high_03 

• Low-poly group 

• low_01 

• low_02 

• Model Group 

• model_01 

• model_02 

 

 

We can then choose any of these elements individually and move around any of the groups 

in an organized fashion with the help of those up and down arrow keys on the keyboard. It 

is very time-saving because it enables us to pick up any element and move it around with 

great swiftness. 
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CHAPTER 4 

 

PROJECT WORKFLOW 

 
4.1 : MODELING: 

 

3D modeling involves manipulating polygons, edges, and vertices in virtual 3D space to 

create representations of surfaces or objects. This technique is widely used in movies, 

cartoons, and video games to create unique and original animals and structures. The impact 

of 3D modeling is extensive, enhancing visual storytelling and interactive experiences. 

 

 

For our project, we have chosen Autodesk Maya 2024 as our modeling program. The game's 

standard primitives include boxes, spheres, lines, and cylinders. We used various 

adjustments to build several models using this approach. Key tools and techniques 

employed include Extrude, Insert, Bridge, Combine, and Nonlinear tools such as Bend and 

Lattice. It was crucial to maintain all polygons in the models as quads during the creation 

process. 

 

 

This detailed workflow should provide a comprehensive overview of your 3D modeling 

process using Autodesk Maya 2024. Below is a summary of all the models I created and 

their various applications. 
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4.1.1: STATUE BOAT MODELING: 

Modeling a boat in Autodesk Maya can be an enjoyable and rewarding process, especially 

if you're aiming to create a detailed, realistic 3D boat model for a scene or animation. Below 

is a step-by-step guide to help you model a boat using Maya, including tips for hull shaping, 

detail work, and texturing. 

 

Figure 4.1.1: Reference of boat shape 

 

With these steps, you should be able to create a 3D boat model in Maya that’s both detailed and 

realistic. The process involves a combination of basic polygon modeling, smoothing, adding 

finer details, and texturing. 
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Figure 4.1.2: Boat Model  

 

 

 

Select the boat’s mesh. Go to UV > Automatic or Unfold to create a basic UV layout. Adjust the 

UVs to minimize stretching and seams, ensuring that textures will apply correctly to the model. 

 

 

Figure 4.1.3: Boat Texturing 
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4.1.2: QURAN STATUE: 

 

Creating a Quran statue in a 3D modeling software like Autodesk Maya involves representing 

the Holy Quran in a respectful, artistic, and detailed manner. Since the Quran is an important 

religious text in Islam, it is essential to approach the modeling process with consideration for 

cultural and religious sensitivities. 

 

 

Figure 4.1.3: Quran model 

 

For a realistic look, use three-point lighting or HDRI lighting. Key Light: Position the key light 

(main light) in front of the Quran to illuminate it. Fill Light: Position a fill light to soften the 

shadows, usually at a lower intensity. Back Light: Position a back light to create a glow or rim 

light effect around the Quran and the stand. Use Arnold or Maya’s native renderer for a final 

render. Adjust the sampling to reduce noise and ensure high-quality results. Set the output 

resolution and aspect ratio based on your final output needs. 

 

 

 

 

 



14 
©Daffodil International University 

 

Figure 4.1.4: Quran Arnold Render 

 

Save your final rendered image or animation in the format you need (e.g., PNG for stills, or MP4 

for animation).  

 

 

Figure 4.1.5: Quran Arnold Render 2 
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4.1.3: JAR MODELING: 

 

If you have reference images for the jar (e.g., a front and side view), you can set them up in the 

front and side viewports to help guide your modeling process. reate a Cylinder: Go to Create > 

Polygon Primitives > Cylinder. In the Channel Box, you can adjust the cylinder’s properties. Set 

the Radius and Height based on the size of the jar you want to create. Increase the subdivisions 

to around 16 or 24 for smoother geometry. Add Edge Loops, Select the jar model and go to Mesh 

Tools > Insert Edge Loop. Add edge loops near the top and bottom of the jar to give it more 

definition. This will allow you to adjust the shape of the body more smoothly. Select your model 

and go to UV > Automatic or Unfold (depending on your needs) to create a UV map. Adjust the 

UVs to avoid stretching, especially around the curved surfaces of the jar.  

Key Light: Main light source to highlight the jar’s details. 

Fill Light:  

Softer light to fill in shadows. 

Back Light: Light behind the object to add a rim effect. 

Alternatively, use an HDRI (High Dynamic Range Image) for realistic global lighting that 

simulates environmental reflections. 

Go to Render Settings (Window > Rendering Editors > Render Settings) and choose Arnold as 

the renderer (or Maya’s default renderer). Adjust the settings for resolution and quality. Click 

Render to create the final image of your jar. 

 

Figure 4.1.6: Jar Key Shot Render  
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4.1.4: SWORD MODELING: 

 

Start with a Cube: 

Go to Create > Polygon Primitives > Cube to create a rectangular shape for the blade. 

In the Channel Box, adjust the Width (X) and Depth (Z) to create the long, narrow shape of a 

blade. Set the Height (Y) to a smaller value, representing the thinness of the blade. 

Create a cylinder for the handle of the sword. Scale the cylinder along the Y-axis to make it 

elongated (the handle of the sword should be proportional to the blade’s length). Adjust the 

radius (X and Z) to make it the appropriate width for the grip. 

 

 

Figure 4.1.7: Sword Key Shot Render 

 

If your sword is going to have detailed textures, you will need to UV map it. 

Select the sword model and go to UV > Automatic or Unfold to create a UV map. 

Adjust the UVs to avoid any stretching, especially on the blade and handle, where textures will be 

most visible. Use three-point lighting for the best effect: 

 Key Light: Light the sword from the front to highlight details. 

 Fill Light: Light from the side to soften shadows. 

 Back Light: Light from behind to create a rim light effect. 
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4.1.5: CRICKET BALL MODEL: 

 

Modeling a cricket ball in Autodesk Maya is a relatively straightforward process that involves 

creating a spherical object and adding fine details to replicate the characteristics of a real cricket 

ball. A cricket ball has a textured, stitched surface and is typically red in color, with a seam 

running around it.  

 

Use Cylinder or Cube primitives to create individual stitches that follow the seam line. Start by 

creating a small Cylinder with very few subdivisions. Position it along the seam where the 

stitching should appear. 

 

Once you’re happy with the placement of the stitches, you can combine the stitches and the ball 

geometry using Mesh > Combine.Select the sphere and go to UV > Automatic to create basic 

UVs for the ball. For better control, you can manually adjust the UVs, but automatic mapping 

should suffice for a basic model. 

 

After rendering, you can use software like Photoshop to enhance the image, adjusting brightness, 

contrast, and color grading to make the cricket ball look even more realistic. Once you're happy 

with the render, export the image as PNG or JPEG for a still image, or use MP4 for animations. 

 

Figure 4.1.8: Cricket Ball Key Shot Render 
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4.1.6: ORGANIC MODELS LOW-POLY USING:  

 

Creating low-poly organic models in Maya is an essential skill for stylized modeling, game 

development, and real-time applications, where performance and optimized meshes are crucial. 

Organic models can range from characters, animals, to plants or even creatures, and using a low-

poly approach means you'll be focusing on clean, minimal geometry while still maintaining a 

recognizable shape and silhouette. 

 

Figure 4.1.9: Mouse low-poly Model 

 

Collect reference images or concepts of the organic object (character, creature, plant, etc.) you’re 

planning to model. For a low-poly model, keep in mind that you’ll want to focus on simple 

shapes with clear silhouettes.Find side, front, and top views to help with proportional accuracy. 

For characters, stylized illustrations or simplified designs often work best. Characters or 

creatures can typically range from 500 to 10,000 polygons for simple low-poly styles. 

Environmental objects like trees or rocks can be even lower. 
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Figure 4.1.10: Penguin low-poly Model 

 

For low-poly organic models, avoid overcomplicating your geometry. Focus on essential 

features.Use quads whenever possible and keep the topology as simple as you can. You can 

always add more detail later, but with low-poly, fewer is more. 

 

 

Figure 4.1.11: Bee low-poly Model 
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4.2: INTERIOR DESIGN: 

 

Interior modeling is the process of creating the 3D shapes that make up the visual world of a 

Client Design. This includes everything from Furniture and vehicles, Props, buildings, and even 

the environment itself. 

I had been created Interior Design. Flat design are high-quality, visually stunning, and 

technically impressive assets used in Radner image. They can include Furniture, environments, 

props, vehicles, bed and more. Use Autodex Maya and SketchUp specialized software to create 

realistic and detailed models and textures. 

 

FOLLOWING PIPELINE: 

 

 

 

 

 

 

 

 

Figure 4.2.1: Following Pipeline 

 

I follow this pipeline for creating my Interior Design. I create model in Autodesk Maya. Used 

high-poly for SketchUp. SketchUp and Maya for texturing. And real-time rendered I used 

SketchUp. 
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4.2.1: ROOM INTERIOR DESIGN (AUTODEX MAYA): 

 

Designing an interior flat for a client in Maya or any other 3D software requires a detailed 

understanding of the client's preferences, the space layout, and any specific features they want. 

Creating a flat interior design typically involves the following stages: planning, modeling, 

texturing, lighting, and rendering. Here's a breakdown of how you can approach interior flat 

modeling to meet your client's demands.  

Before starting the actual 3D modeling, ensure you have a detailed understanding of your client’s 

needs: 

Style Preference: Modern, contemporary, minimalist, rustic, industrial, etc. 

Color Scheme: Does the client have specific color preferences or themes in mind? 

Functional Requirements: How many rooms? Any specific furniture pieces or layout 

requirements (e.g., an office space, guest room)? 

Budget Considerations: How detailed or high-end does the design need to be? (This will 

influence the level of detail and realism) 

Mood and Atmosphere: Does the client want a cozy, luxurious, or casual atmosphere? Lighting, 

materials, and textures will play a big part here. 

 

 

Figure 4.2.2: Drawing Room Arnold Render   
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Figure 4.2.3: Drawing Room Arnold Render 2   

 

Use simple polygonal cubes to create the walls of the flat. Begin by modeling the four walls (if a 

rectangular layout) using extrusion or box modeling techniques. Be mindful of thickness for 

walls, and doorways and windows as you model. 

 

 

Figure 4.2.4: Dining Room Arnold Render    
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Figure 4.2.5: Master Bed Room Arnold Render  

 

   

Figure 4.2.6: Shoe Self Arnold Render    

 

After modeling, unwrap the UVs for your furniture and walls. This will help you apply textures 

properly. 

 

Use Automatic Mapping or Planar Mapping for flat surfaces like walls, while Cylindrical 

Mapping is good for round surfaces like columns or vases. Set up a key light to illuminate the 

scene and create shadows. 
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Add a fill light to reduce harsh shadows and a back light to highlight the edges and depth of the 

room. 

Ambient Light: 

 

Use a directional light or spotlight to simulate daylight coming from windows, if required. 

You can also use an HDRI image for realistic global illumination, especially if you're going for a 

more realistic render. 

Point Lights: 

 

For lamps or small light fixtures, place point lights near the light sources for realistic lighting 

effects. 

 

 

Figure 4.2.7: Shoe Self Arnold Render 2   

 

Set up multiple cameras in the scene to capture different views of the flat (e.g., a wide-angle shot 

of the living room, close-ups of furniture). Position the camera at the appropriate height and 

angle, and use Depth of Field for realistic focus effects.  
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Figure 4.2.8: Bathroom 1 Arnold Render 

 

 

Figure 4.2.9: Bathroom 2 Arnold Render 

 

 

Arnold (Maya's default renderer) or V-Ray (for more photorealistic results) are great choices for 

interior rendering. Set render settings for high quality, and choose a resolution that works for the 

project (e.g., 1920x1080 for standard renders). 
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4.2.2: ROOM INTERIOR DESIGN (SKETCHUP): 

 

Designing an interior flat in SketchUp is a streamlined process due to its user-friendly interface 

and powerful tools tailored for architectural and interior design. Below is a step-by-step guide on 

how to create a flat design in SketchUp from start to finish. This includes floor planning, modeling, 

texturing, and rendering the interior design. 

 

SketchUp is a popular 3D modeling software used for creating architectural designs, interior 

designs, and other types of 3D models. While SketchUp is typically used for 3D modeling, it can 

also be used to create flat designs (2D designs or illustrations). 

 

After exporting, D5 Render will launch automatically (or you can open it manually). 

The model should appear in D5 Render. Now, you can use D5's advanced rendering tools to 

produce high-quality renders of your flat design. 

 

 

Figure 4.2.10: Drawing Room D5 Render 

 

Choose a Standard View: If working on a flat design, you will want to use the 2D or "plan" view 

in SketchUp. This is typically the Top View (found in the Views menu or by selecting the "Top" 

standard view from the toolbar). 
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Turn Off Perspective: Make sure that not in a perspective view. SketchUp's default view is in 

perspective, but for flat design, you want to be working in parallel projection to ensure that your 

lines and shapes remain true to scale. 

 

 

 

Figure 4.2.11: Drawing Room D5 Render 2 

 

If we want to create a flat design render in SketchUp and then use D5 Render for rendering, the 

process typically involves designing in SketchUp first and then exporting the model to D5 Render 

for high-quality rendering. 

 

Use the camera controls in D5 to set your desired view. For flat design, Client want to use an 

orthographic view (no perspective distortion) to keep everything aligned. 

 

Also adjust the focal length to ensure that your design looks accurate in terms of proportions. 
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Figure 4.2.12: Dining Room D5 Render 

 

 

Figure 4.2.13: Room 1 D5 Render 

 

D5 Render provides real-time lighting controls. Even for a flat design, proper lighting can make a 

huge difference in how materials and shadows appear. Experiment with sunlight, environmental 

lighting, and artificial lights to create the right atmosphere. 
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Figure 4.2.14: Room 2 D5 Render 

 

 

Figure 4.2.15: Room 2 D5 Render 2 

 

After rendering, we can tweak the image in D5’s post-processing panel. You can adjust things 

like contrast, brightness, and saturation to get the exact look you want for your flat design render. 
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Figure 4.2.16: Bathroom 1 D5 Render 

 

 

Figure 4.2.17: Bathroom 2 D5 Render 

 

Creating a flat design render in SketchUp and D5 Render involves setting up your design in 

SketchUp, exporting it to D5 Render using the plugin or manual export, and then using D5 

Render’s powerful real-time rendering tools to enhance the design with high-quality materials, 

lighting, and rendering settings.  
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Creating a kitchen model in SketchUp and rendering it with D5 Render involves a few essential 

steps. 

 

 

Figure 4.2.18: Kitchen area D5 Render 

 

 

Figure 4.2.19: Kitchen area 2 D5 Render 

If we want ultra-realistic results, be prepared for longer render times, especially if you’re using 

advanced lighting and textures. 
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CHAPTER 5 

 

CHALLENGES 

 

Throughout my internship, I encountered various challenges, including complex geometric  

shapes, intricate surface details, and integrating cultural authenticity into my designs. For  

instance, modeling the Interior required meticulous attention to historical references and material 

textures to accurately portray its aged appearance. Each challenge was an opportunity to innovate 

and refine my modeling techniques, often seeking guidance from mentors and leveraging online 

resources to overcome technical hurdles.  

 

Render time is a significant consideration in creating computer graphics, and the absence  

of a dedicated graphics card posed difficulties in texturing, lighting, and rendering in  

D5. Programs like D5 render utilize a GPU for smooth functioning, making dedicated graphics 

processing power essential for handling complex textures and real-time rendering.  

 

Working on the 3d modeling and interior project, I faced numerous problems, including  

crashes in Maya and Sketchup files, which forced me to restart from scratch. High-poly  

models needed to be optimized for efficient use in a Design, involving reducing the  

polygon count while maintaining visual quality. Tools like re-topology and baking  

techniques were explored to achieve this.  

 

Despite the poor resources available for creating Interior Design, I successfully completed my  

projects by overcoming challenges with the help of online resources and my internship  

supervisor. Creating complex shapes and maintaining high-quality models required  

persistence and innovative problem-solving.   
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CHAPTER 6 

 

CONCLUSION 

 

In today's world, almost every platform includes a 3D editor as a basic function, offering 

endless variations for realizing any project. This capability is crucial for Interior art, Interior 

design creation, and product modeling, enabling businesses to present their initiatives to 

customers in the most favorable light. 

 

During this study, we explored various 3D modeling methods and techniques. We reviewed 

three main software packages for three-dimensional modeling and selected the most 

suitable ones for my project. This allowed us to expand our knowledge of new software 

while deepening our expertise with familiar tools. The workflow, modeling techniques, and 

UV unwrapping texturing described in the Challenge paper were instrumental in this 

process, and we learned a completely new UV method, enhancing the precision and 

accuracy of our models. 

 

Our efforts resulted in highly accurate and well-shaped models, promising a better return 

on investment for our clients. The concept of 3D modeling and Interior for advertising is 

relatively new in our country, and our project sets a high standard for future developments 

in this field. 

 

I am Tanvir Jaman, a student of Multimedia and Creative Technology at Daffodil 

International University. This report, titled " Explore 3D Modeling and Interior Design 

Technique Through the Internship at Idea Lab," reflects my journey and 

accomplishments in this project. 

 

THANK YOU 
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